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OUR BRAND STRATEGY SETS AND ALIGNS VISUAL AND VERBAL 
STANDARDS AROUND THE WORLD AND ACROSS ALL OF THE 
COMPANIES IN THE LIGHTSPEED FAMILY   

BRANDING & 
VISUAL IDENTITY
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THE UNIFIED LIGHTSPEED BRAND
Since 1996, Lightspeed has been committed to a comprehensive 
approach to Quality: Quality online panels, Quality data and Quality 
products.

With the rollout of the Lightspeed Group and the family of brands –
Lightspeed GMI, Lightspeed All Global, Lightspeed FSG – it is 
paramount at this time to focus on a unified Lightspeed brand that 
spans all companies and all employees around the world. This means a  
consistent voice, message, and recognizable visual identity. 

Our brand needs to personify the universal focus towards which 
Lightspeed has always driven the company: Quality. 
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BRAND POLICY
In order to achieve a consistent and quality message, all Lightspeed Group 
businesses – including their team members, contractors and vendors – have 
the responsibility to understand, use and reinforce the expression of our brand 
correctly and consistently. This includes compliance with all components of the 
Lightspeed branding and its brand standards.

As the Lightspeed Group family of brands (Lightspeed GMI, Lightspeed All 
Global and Lightspeed FSG) continues to grow, it is more critical than ever for 
us to be a consistent and recognizable force in the marketplace. To achieve 
consistency company-wide, each employee must do their best to comply with 
our brand guidelines.

Each employee must take personal responsibility to ensure that he or she is 
working within all branding guidelines at all times, to read this document and 
update personal files. 
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BRAND DEVELOPMENT
The new brand strategy initiative was launched to meet several objectives:

• Fully integrate and merge the legacy Lightspeed Research and GMI brands into one 
unified brand

• Fully integrate and align the All Global business into the Lightspeed family
• Reposition the Financial Services Group as a key player in the market
• Energize and distinctly position the Lightspeed brand to drive business
• Give clients new reasons to take a new or renewed interest in Lightspeed GMI and 

Lightspeed All Global
• Create market awareness of the range of Lightspeed offerings
• Drive marketing and communication efficiencies
• Attract the best team members, build team member engagement and retention
• Reinforce our position as an industry leader
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LIGHTSPEED GMI 

VISUAL IDENTITY OVERVIEW
Our brand elements set the foundation for the Lightspeed GMI visual identity. The combination of 
elements – logos, colors, icon images and typography – help us express the Lightspeed GMI brand 
powerfully and uniquely. These elements must be used consistently to help us differentiate our brand 
from our competitors and create preference with clients and prospects. 

LOGO

COLOR

TYPOGRAPHY

ICON IMAGERY

ARIAL
AaBbCcDdEeFfGgHgIiJjKkLlMmNnOoPpQ
qRrSsTtUuVvWwXxYyZz

CENTURY GOTHIC
AaBbCcDdEeFfGgHgIiJjKkLlMmNnOoP
pQqRrSsTtUuVvWwXxYyZz
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KEY VISUAL ELEMENTS 
OF THE BRAND DESIGN

USE OF WHITE AND WHITE SPACE
White is a unifying element in our 
communications materials, from print to web to 
signage. This ensures all of our materials are 
highly legible and helps our message stand out.

WHITE PAPER
Lightspeed GMI materials should always have a 
clean, fresh and contemporary look and feel. Use 
only white paper for all materials. Do not use off-
white, cream or color paper. Do not print a 
background color effect. 

A GRAY BASE
In addition to white space, our materials use 
shades of gray as the base for our materials. The 
grays in our logo tie all of our materials together. 
The logo orange is the preferred highlight color, 
followed by the rest of the branded color palette. 

USING COLOR
Adding color is a lot like adding spice while 
cooking: a little can go a long way. In 
planning communications, the formula is 
white space plus gray elements as a base, 
then the addition of a main color. The color 
can be used monochromatically in different 
shades on the same page, slide or visual. In 
certain cases, an additional accent color 
can be added when necessary to highlight 
an important message or idea. Do not use 
more than 2 colors on a page or slide. Do 
not use gradients or special effects. For 
more on color go to page 18. 
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THE LIGHTSPEED FAMILY OF LOGOS
LIGHTSPEED GMI, LIGHTSPEED ALL GLOBAL, LIGHTSPEED FSG 
AND THE LIGHTSPEED GROUP 

LOGOS
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THE LIGHTSPEED FAMILY OF LOGOS
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LIGHTSPEED GMI LOGO
The Lightspeed GMI logo should be used for 
all Lightspeed GMI business and materials. It 
replaces both the Lightspeed Research and 
GMI logos in all instances. The old Lightspeed 
Research and GMI logos should no longer be 
used. 

• The Logo files are available on The 
Source, The Hub, and SharePoint in a 
.jpg format with a white background or in 
a .png format with a clear background

• The Gray Text version is for use on white 
or light color backgrounds

• The White Text version is for use on dark 
backgrounds

• Logo colors include Logo Orange, Logo 
Light Orange, Logo Dark Gray and Logo 
Light Gray; Extra Light Gray and White 
(white text version only). The color codes 
are available on page 19.  

The logo must never be altered, modified, or recreated. Any attempt 
to alter or modify our logo is a direct violation of our Brand Policy. 
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The Lightspeed All Global logo should be 
used for all Lightspeed All Global business 
and materials. It replaces the previous All 
Global logo in all instances. The old All Global 
logo should no longer be used. 

• The Logo files are available on The 
Source, The Hub, and SharePoint in a 
.jpg format with a white background or in 
a .png format with a clear background

• The Gray Text version is for use on white 
or light color backgrounds

• The White Text version is for use on dark 
backgrounds

• Logo colors include Logo Orange, Logo 
Dark Gray, and Logo Light Gray; and 
Logo Extra Light Gray and White (white 
text version only). The color codes are 
available on page 19.  

The logo must never be altered, modified, or recreated. Any attempt 
to alter or modify our logo is a direct violation of our Brand Policy. 

LIGHTSPEED ALL GLOBAL LOGO
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The Lightspeed Financial Services Group logo 
should be used for all Lightspeed FSG 
business and materials. The old FSG logo 
should no longer be used. 

• The Logo files are available on The 
Source, The Hub, and SharePoint in a 
.jpg format with a white background or in 
a .png format with a clear background

• The Gray Text version is for use on white 
or light color backgrounds

• The White Text version is for use on dark 
backgrounds

• Logo colors include Logo Orange, Logo 
Light Orange, Logo Dark Gray and Logo 
Light Gray; Logo Extra Light Gray and 
White (white text version only). The color 
codes are available on page 19.  

The logo must never be altered, modified, or recreated. Any attempt 
to alter or modify our logo is a direct violation of our Brand Policy. 

LIGHTSPEED FSG LOGO (AMS ONLY)
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The Lightspeed Group logo represents the 
Lightspeed family of brands and should only 
be used in limited instances when a specific 
material or communication spans across the 
entire company (i.e. a company-wide internal 
presentation, memo, or document). 

• The Logo files are available on The 
Source, The Hub, and SharePoint in a 
.jpg format with a white background or in 
a .png format with a clear background

• The Gray Text version is for use on white 
or light color backgrounds

• The White Text version is for use on dark 
backgrounds

• Logo colors include Logo Orange, Logo 
Light Orange, Logo Dark Gray and White 
(white text version only). The color codes 
are available on page 19.  

The logo must never be altered, modified, or recreated. Any attempt 
to alter or modify our logo is a direct violation of our Brand Policy. 

LIGHTSPEED GROUP LOGO
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LOGO CLEAR SPACE
Our logo is one of our most valuable 
assets. Always position it for maximum 
impact and give it plenty of room to 
“breathe.” 

Clear space frames the logo, separating 
it from other elements such as 
headlines, text, imagery, and the 
outside edge of printed materials.

The examples shown to the right 
represent the preferred and minimum 
clear space.

The preferred amount of space around 
the logo is ½ of the height.

The minimum amount of space around 
the logo is ¼ of the height. 

Y Y

½ Y

½ Y

½ Y ½ Y

½ Y½ Y

½ Y

½ Y

Y

¼ Y

¼ Y

¼ Y

¼ Y

¼ Y ¼ Y

¼ Y ¼ Y

Y

PREFERRED: ½ OF THE HEIGHT (Y)

MINIMIUM: ¼ OF THE HEIGHT (Y)
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LOGO SIZE AND PLACEMENT
In reproducing our logo, consider 
its size and legibility and use your 
best judgment. A logo that is too 
small to read ceases to serve its 
communicative function.

The preferred placement of the 
Lightspeed GMI logo is the 
bottom right corner of the material 
for  printed materials, Word 
documents and PowerPoint 
slides. 

For web and email 
communications, the logo should 
be on the top header.

SMALL BUT LEGIBLE: TOO SMALL:

16
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INCORRECT LOGO USAGE

DO NOT – stretch or alter the logo in any way

DO NOT – place the logo on 
backgrounds that limit legibility

DO NOT – use the words alone

DO NOT – lock up photos with the logo

DO NOT – recreate or retype the 
name in the logo

DO NOT – give the logo outlines or 
special effects

Do not – replace or modify the swoosh

DO NOT – lock up icons with the logo

DO NOT – change the logo colors

DO NOT – use graphic effects like 
shadows, reflections or embossing

DO NOT – use the logo as a read-
through in text 

DO NOT – use the logo in outline form
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COLORS
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MAIN COLOR PALETTE

Logo Orange

PMS #157C
RGB: 247, 150, 76
CMYK: 0, 49, 78, 0
Web #F7964C

Logo Light Orange

PMS# 714C
RGB: 251, 180, 124
CMYK: 0, 34, 55, 0
Web #FBB47C

Logo Dark Gray

PMS# Cool Gray 11
RGB: 67, 67, 67
CMYK: 67, 60, 59, 45
Web #434343

Logo Light Gray

PMS# Cool Gray 8
RGB: 140, 140, 140
CMYK: 47, 39, 40, 4
Web #8C8C8C

Light Gray 2

PMS# Cool Gray 4
RGB: 201, 200, 199
CMYK: 19, 16, 16, 1
Web #C9C8C7

Logo Extra 
Light Gray

PMS# Cool Gray 1 
RGB: 241, 242, 242
CMYK: 0, 0, 0, 5
Web #F1F2F2

Lime Green

PMS# DS 303-3
RGB: 182, 204, 66
CMYK: 33, 4, 94, 0
Web #B6CC42

Green

PMS# DS 282-3
RGB: 113, 195, 121
CMYK: 58, 0, 71, 0
Web #71C379

Blue-Green

PMS# DS 256-5 
RGB: 107, 179,  176
CMYK: 50, 0, 25, 15
Web #6BB3B0

Blue

PMS# 7456C
RGB: 100, 126, 190
CMYK: 65, 48, 0, 0
Web #647EBE

Red

PMS# DS 90-2
RGB: 242, 99, 84
CMYK: 0, 76, 67, 0
Web #F26354

Yellow

PMS# 127C
RGB: 244, 225, 110 
CMYK: 6, 6, 69, 0
Web #F4E16E
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COLOR TINTS/SHADES
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COLOR USAGE
A little color goes a long way. 
In planning a slide, the formula is: 
plenty of white plus shades of gray 
for the base. Then we add a main 
color. Tints of the main color can 
be used for a monochromatic look, 
mixed with shades of gray. 

Sometimes an additional accent 
color is needed to highlight 
important information, but less is 
more when designing a slide.  
DO NOT use more than two (2) 
colors on a slide or page. 

1. WHITE SPACE + 2. GRAY BASE + 3. MAIN COLOR

White is simple and clear and 
allows us to highlight our text 
and icons in a compelling way. 

1. WHITE SPACE + 2. GRAY BASE + 3. MAIN COLOR + 
4. ACCENT COLOR

2

2

2

2

1

1

3 3 3

3 3 3 3

4
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COLOR EXAMPLES

WHITE SPACE + GRAY BASE + 
SHADES OF BLUE-GREEN + 
ORANGE ACCENT 

WHITE SPACE + GRAY BASE + 
SHADES OF LIME GREEN + 
ORANGE ACCENT 
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COLOR “DO NOT” EXAMPLES
• Do not use too many colors on one 

page (no rainbows), keep the pages 
monochromatic and shades of gray. 
Use an accent color sparingly. (The 
only exception to this rule are charts 
and graphs.)

• Do not highlight text in any color 
other than orange or shades of gray

• Do not use color backgrounds for 
materials. White is preferred, but if a 
dark background is needed, use gray

• Do not use gradients of our colors

• Do not use special effects (bevel, 
emboss, shadows, etc.) 

LOREM IPSUM DOLOR SIT AMET. 
CONSECTETUER ADIPISCING ELIT. 
MAURIS ULLAMCORPER
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CORPORATE FONTS AND USAGE

TYPOGRAPHY
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CORPORATE FONTS

Century Gothic
abcdefghijklmnopqrstuvwxyz
ABCDEFGHIJKLMNOPQRSTUVWXYZ

Arial
abcdefghijklmnopqrstuvwxyz
ABCDEFGHIJKLMNOPQRSTUVWXYZ

As part of the new global brand, all internal and external facing documents 
require the EXCLUSIVE use of the CENTURY GOTHIC (titles) and Arial (body 
text) fonts. No other fonts are permitted.
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TYPOGRAPHY GUIDELINES

USE CENTURY GOTHIC, ALL CAPS, FOR TITLES AND 
HEADERS. 
Use Arial for body text, sidebar text, footers and copyright information. Follow 
the template guidelines and presets for PowerPoint and Word.

USE CENTURY GOTHIC, ALL CAPS, FOR SUBTITLES AND CHARTS
Use sentence case for body text. Do not use Arial in all caps. 

To highlight or draw attention to specific body text use the designated highlight 
colors of light gray or orange. For additional emphasis, the text can be changed 
to CENTURY GOTHIC IN ALL CAPS or bolded. Do not use more than one style 
of emphasis PER PRESENTATION DECK. Do not use underlining for emphasis.
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IMAGERY
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IMAGERY
The Lightspeed GMI brand uses icons
and simple icon style illustrations for 
the main imagery.

Adding imagery is an excellent way to 
make a page more visually appealing 
and easier to read by breaking up too 
much text. 

The icon imagery should be relevant 
to the topic on the page. Unrelated 
decorative imagery confuses the 
reader and dilutes the message. 
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ICON IMAGES
Our icon graphics are contemporary, 
colorful and engaging. This helps 
Lightspeed GMI communicate in a clear 
way that is easy for people to 
understand.

All of our approved icons are available 
on The Hub in the Image Library under 
Icons. The approved icons are custom 
created by the design team and 
proprietary property of Lightspeed GMI. 

To request a new icon, please fill out the Icon Request Submission 
form available on The Hub and submit your request to 
marketing@lightspeedresearch.com with “New Icon Request” in 
the subject line. A marketing representative will review your 
request and get back to you shortly. 
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ICON SQUARES

Part of the Lightspeed 
GMI brand is to use 
icon squares to help 
break up text and 
illustrate ideas.

Icon squares are 
available on The Hub 
in the Image Library 
under Icons. 

Strategically placed 
icons help direct the 
flow of the page and 
make it easy for the 
reader to find the 
heart of our message.

Icon squares are 
designed to be gray 
with rounded corners 
to stand out on white 
backgrounds.
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ICON  ILLUSTRATIONS

The icon illustrations are 
icon images with clear 
backgrounds. 

A full suite of gray images are 
available on The Hub. 

31

https://lightspeedresearch.sharepoint.com/teams/Marketing/SitePages/Image Library - Icon Images.aspx�


Copyright © 2014 Lightspeed, LLC. Proprietary and Confidential. All rights reserved.

COLOR IMAGES
As part of the new more colorful brand, color icon illustrations in our 
branded colors are now available in the Image Library on The Hub.

When using color images, 
you need to follow the color 
guidelines outlined on slides 
21-23. Pages should kept 
monochromatic (i.e., one 
color in different shades / 
tints) with shades of gray. A 
single accent color may be 
added (more on slide 33), 
but too many colors together 
becomes distracting. 

WHITE SPACE + GRAY BASE + MAIN COLOR
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USING ACCENT COLORS WITH IMAGERY
LESS IS MORE when it comes to color. Sometimes an accent color is needed to help 
illustrate an idea or highlight an important message. 

Accent colors are reserved to 
for shapes (including icon 
squares and circles) or to 
highlight important information. 

WHITE SPACE + GRAY BASE + MAIN COLOR + ACCENT COLOR

Do not use more than two 
colors plus shades of gray 
on a page. 
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PHOTOGRAPHY
In certain instances, iconography 
cannot be used and specific 
presentations / materials will 
require photographs instead. 
Photos are to be used sparingly 
and only in necessary situations.

Icon illustrations and photos 
should NEVER be mixed on the 
same slide.

A selection of purchased images 
can be found in the Image Library 
on The Hub.

34
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IMAGERY 

DO’S & DON’TS
DON’T Mix Photos and Icons

DON’T Mix lots of colors together

DO Use Icons exclusively

DO Keep the slide monochromatic
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THEMES & TEMPLATES IN
MICROSOFT OFFICE

36
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WHAT IS A THEME?
A theme is a fast and easy way to apply the Lightspeed GMI 
corporate colors and fonts to any Microsoft Office file including 
PowerPoint, Word and Excel.

As part of the new global brand, all internal and external facing 
documents require the EXCLUSIVE use of the corporate colors 
and fonts (CENTURY GOTHIC TITLES and Arial Body text). 

All other fonts and colors are no longer permitted. 
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HOW TO SAVE AN OFFICE  THEME 
The fastest and easiest way to ensure the proper colors and fonts in any 
application is to save the LightspeedGMI_2014.thmx theme file to your 
computer. This file is available on The Hub. 

TO SAVE THE THEME:
1. Right click on the LightspeedGMI_2014.thmx

file and select Save As.

2. If the folder doesn’t automatically reroute to 
Document Themes, navigate to My Computer
and select the C: drive, then select Users 
folder and find your username folder. Open 
this folder and navigate through App data> 
Microsoft> Templates> Document Themes. 

3. Name your file “LightspeedGMI_2014.thmx” 
and click save. This will save your theme for 
use in all Microsoft Office applications. 

TO USE THE THEME IN:
• PowerPoint – See Slide 30
• Word – See Slide 33
• Excel – See Slide 32
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POWERPOINT THEMES & TEMPLATES
THE LIGHTSPEED GMI 2014 THEME 
AND TEMPLATE
should be used for all Lightspeed GMI 
presentations

THE LIGHTSPEED GROUP / LIGHTSPEED 
GMI / LIGHTSPEED ALL GLOBAL MULTI-
BRANDED TEMPLATE AND THEME
should be used for all presentations that span 
across all of the Lightspeed Group brands

All of the templates and themes are available on The Hub, in the Marketing section under Templates.  

39

https://lightspeedresearch.sharepoint.com/teams/Marketing/_layouts/15/start.aspx�


Copyright © 2014 Lightspeed, LLC. Proprietary and Confidential. All rights reserved.

HOW TO SAVE & USE 

A THEME OR TEMPLATE IN POWERPOINT 
THEME:
1. Right click on the 

LightspeedGMI_2014.thmx file and 
select Save As.

2. Navigate to My Computer and select the 
C: drive, then select Users folder and 
find your username folder. Open this 
folder and navigate through App 
data>Roaming>Microsoft>Templates>
Document Themes. 

3. Name your file and hit save. 

4. Open PowerPoint To apply this theme to 
a new or current presentation, select the 
Design tab and choose the Lightspeed 
GMI 2014 Theme thumbnail.  

POWERPOINT TEMPLATE:
1. Open the .potx file in PowerPoint on your 

computer (not your internet browser). 

2. In PowerPoint go to File>Save As.
3. At the bottom of the window, in the Save As 

Type drop-down menu, select “PowerPoint 
Template (.potx).” This will automatically 
reroute you to the Microsoft Office Design 
Template folder on your computer. If not, 
navigate to My Computer and select the C: 
drive, select Users folder, find your 
username folder,  Open and navigate to 
App Data> Roaming> Microsoft> 
Templates.

4. Choose a file name for the template and Save.

5. Close PowerPoint.

6. Reopen PowerPoint. The new design template 
will be conveniently located in you’re My 
Templates menu when you to the Office 
Button>New to create a new file. The My 
Templates option is under Templates on the 
upper left side in the new pop-up window.
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EXCEL THEME
TO OPEN A THEME IN EXCEL: 
Open Microsoft Excel. To apply the theme to a new or 
current document, select the Page Layouts tab  and 
choose the LightspeedGMI_2014 Theme thumbnail from 
the Themes Dropdown Menu on the left. 

The Lightspeed GMI branded color scheme and fonts will 
then be automatically applied to the Excel file.

These two steps are a very fast and convenient way to 
apply the branded color scheme and fonts to charts, tables 
and graphs and minimizes the work involved in producing 
branded charts and graphs in Excel. 
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WORD THEME
TO OPEN A THEME IN WORD: 
Open Microsoft Word. To apply the theme to a new or current 
document, select the Page Layouts tab  and choose the 
LightspeedGMI_2014 Theme thumbnail from the Themes 
Dropdown Menu on the left. 

The Lightspeed GMI branded color scheme will then be 
automatically applied to the document. This is especially 
helpful for adding charts, tables and graphics to a Word 
document.

The theme fonts are also brought to the top of the list for 
convenient use. 

While the Lightspeed GMI theme makes colors and fonts more 
convenient in Word, the Lightspeed GMI Word Doc Templates 
are the best and most convenient way to make branded 
documents. See slide 43 for more on Word Templates. 
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WORD TEMPLATES
Word Templates are the fastest and easiest way to apply the Lightspeed GMI branding to 
your Word Docs. The fonts and headings are preloaded; the logos, headers and footers 
are set up. The files are available on The Hub.

THE LIGHTSPEED GMI 2014 
WORD TEMPLATES
should be used for all Lightspeed GMI docs.

THE LIGHTSPEED GROUP / LIGHTSPEED GMI / 
LIGHTSPEED ALL GLOBAL MULTI-BRANDED 
WORD TEMPLATES
should be used for all docs that span across all of the 
Lightspeed Group brands (such as internal company 
wide documents). 

MULTIPLE TEMPLATES FOR ALL YOUR NEEDS. 
All of the templates for Lightspeed GMI and Lightspeed Group are available in two sizes (A4 and 
8.5x11), two formats (with and without a cover), and two styles (all gray or color stationary)
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SAVING WORD TEMPLATES
TO SAVE A WORD TEMPLATE:

1. Open the .dotx file in Word on your computer 
(not your internet browser). 

2. In PowerPoint go to File> Save As

3. At the bottom of the window, in the Save As 
Type drop-down menu, select “Word 
Template (.dotx).” This will automatically 
reroute you to the Microsoft Office Design 
Template folder on your computer. If not, 
navigate to My Computer and select the C: drive, 
select Users folder, find your username folder,  
Open and navigate to App Data> Roaming> 
Microsoft> Templates.

4. Choose a file name for the template and click 
Save.

5. Close Word and Reopen it. The new design 
template will be conveniently located in you’re 
My Templates menu when you create a new 
doc. Select the Office Button>New, and the 
new presentation pop-up window will come up. 
The My Templates option is under Templates
on the upper left side in the new presentation 
pop-up window.
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LETTERHEAD

Office Letterhead is available in 
Word for each Lightspeed GMI 
office around the globe. 

All AMS office letterhead files are 
in 8.5x11 format. All EMEA and 
APAC office letterhead files are in 
A4 format. 

The files are available on
The Hub.
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COMMUNICATIONS
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COMMUNICATIONS: TONE OF VOICE
OUR VERBAL, WRITTEN AND VISUAL IDENTITIES COMING TOGETHER 
Like our visual identity, our verbal and written identity stems directly from our brand purpose and our 
positioning. It expresses clarity, energy, confidence and forward movement. In our visual identity, we channel 
all the insights and connections of our global teams to clearly communicate to our clients and stakeholders. 

Think of your writing in the same way. People inevitably associate clear writing with clear thinking, and 
accurate writing with a broader ability to pay attention to detail. So it is essential we write clearly and 
accurately in all our communications — particularly those we send to clients. Whether written or verbal, its is 
important that all Lightspeed GMI communications convey the same tone by reflecting our brand promise and 
our core attributes: quality and innovation. 

EACH MESSAGE , NO MATTER THE AUDIENCE, SHOULD  CONTAIN THE 
FOLLOWING CHARACTERISTICS:

• Honest

• Knowledgeable 

• Proactive 

• Professional 
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STYLE GUIDE
The Lightspeed GMI style guide will help you produce text that is 
clear and readable. This means choosing words and 
expressions that a global readership can understand. 

Our focus in developing this guide is to use language clearly, 
accurately and consistently. But clear writing also depends 
heavily on planning what we want to say, using structure 
effectively and making sure our that words and design work 
POWERFULLY together. 

Our writing style guide, Strengthening our brand through words, 
will be available in Q4 2014 on The Hub. 
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MESSAGING
We have made changes to our corporate messaging to reflect the adoption of our new 
purpose and positioning, and the use of Lightspeed GMI, Lightspeed All Global and 
Lightspeed FSG as consistent brand names. Extending our brand is an important part of 
how we reach new audiences and build deeper relationships with clients and other 
stakeholders.

Within our written communications, we need to write in a “tone of voice” that is identifiably 
ours. To help you do this, focus on the three pillars of the positioning when putting a 
deliverable together.  With this structure, we can be confident that we are supporting the 
global organization’s vision of strengthening our brand.
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MESSAGING

50

INSIGHTFUL 
Make sure to have a point of view 
and that what you are saying is 
relevant and distinctive. State the 
positive outcomes of Lightspeed 
GMI’s involvement. 

Write confidently, avoiding words 
such as “probably” and 
“perhaps.” Highlight facts, white 
papers, case studies and 
endorsements. Pull out key 
action points for readers to 
consider: use the imperative 
forms, where appropriate. 

RESPONSIVE
Think carefully about the 
reader’s needs and reflect 
them in your content. 
Adjust your language 
according to your reader’s 
culture and  technical 
understanding.. 

Focus on outcomes and 
opportunities. Structure 
your writing to express a 
sense of progress. 

CONNECTED 
Acknowledge the reader’s 
key issues and how 
Lightspeed GMI can 
address them. Create 
energy by keeping your 
sentences and paragraphs 
short and varying the pace 
of your writing. 

Address the reader directly 
– use “you” and “we” often. 
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BOILERPLATE
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Lightspeed GMI is an award-winning global digital data collection 
enterprise. Founded in 1996, its innovative technology and proven 
sampling methodologies deliver operational excellence throughout the 
online research process. With more than four million online research 
respondents in 40+ countries, Lightspeed GMI’s proprietary panels 
deliver unparalleled quality, capacity and targeting. Its comprehensive 
portfolio, including Lightspeed All Global and Lightspeed Financial 
Services Group, offers the tools and services needed to generate 
dependable research results. 

Headquartered in Warren, New Jersey, Lightspeed GMI is part of the 
Kantar Group, the insight, information and consultancy division of WPP, 
the world leader in marketing communication services. For more 
information, visit www.lightspeedgmi.com. 

http://www.lightspeedgmi.com/�
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PROOF POINTS
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INDUSTRY LEADER 
Lightspeed GMI is the leading provider of online 
access panels for global market research. From 
healthcare specialists and financial solutions to 
mobile web survey platforms, Lightspeed GMI offers 
a variety of solutions. 

LOCAL MARKET KNOWLEDGE 
With more than 700 staff situated in 13 countries 
throughout the Americas, Europe and  Asia Pacific, 
Lightspeed GMI has extensive local market 
experience. 

CONNECTING CLIENTS TO DIGITAL 
CONSUMERS 
From attitudes and behaviors to exposures and 
profiling, Lightspeed GMI delivers a 360 degree 
view of what consumers think, see and do through 
its comprehensive product suite. 

DEEPLY PROFILED PANELISTS 
Through deeply rooted, high quality panels, 
we partner with broad reach portals and 
special interest sites, resulting in diverse 
panelist profiles. Our panelists are deeply 
profiled so that they can be easily matched 
to your research needs. We offer quick and 
accurate feasibility estimates based on our 
deep understanding of our panelists. 

COMPREHENSIVE QUALITY 
At Lightspeed GMI, we employ a 
comprehensive approach that is built upon 
our propriety Quality Suite fieldwork quality 
methodology. Beginning with expert survey 
design, Lightspeed GMI ensure high quality 
data output and delivery through expert 
data processing. Our premier product, 
Honesty Detector, adds critical quality 
control to externally sources respondents. 
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COPYRIGHT

Lightspeed GMI, Lightspeed All Global, and Lightspeed FSG are all part of the Lightspeed 
Group. Lightspeed Research, GMI / Global Market Insite, and All Global names should no 
longer be used in the copyright. Lightspeed is headquartered in Warren, NJ, where we are 
incorporated as Lightspeed, LLC. The standard copyright for all of materials reflects the 
Lightspeed, LLC incorporation, however Lightspeed is registered differently in various 
countries around the world (such as Lightspeed Ltd.). If the copyright needs to be updated 
in your country to reflect the legal Lightspeed registration name, it is the responsibility of 
the individual employee to ensure that the copyright year and legal company name are 
correct on their presentations. 

All materials, printed and digital, should include the correct copyright information 
in the footer. 

“Copyright © 2014 Lightspeed, LLC. Proprietary and Confidential. All Rights Reserved.”
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EMAIL & EMAIL SIGNATURES
Email messages are an important communication vehicle and need to reflect 
the corporate brand, internally and externally. 

All employees must follow all email standards and guidelines, using Arial 
(preferred) or Century Gothic fonts in black 10 pt. for all email body text. 

All employees must use the 
standard email signature for all 
email communications. Please refer 
to the detailed Email Signature 
Instructions document, available on 
The Hub to set up your email 
signatures and update your default 
email font. 
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TWITTER, FACEBOOK, LINKEDIN, ETC. GUIDELINES

SOCIAL MEDIA
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SOCIAL MEDIA: TWITTER
• Following @LightspeedGMI on Twitter 

for updates on external events, 
industry conferences and the 
promotion our thought leadership.

• Retweeting the Lightspeed GMI posts 
is strongly encouraged.

Note: As an employee of Lightspeed GMI, your online behavior on personal,  private or public social media accounts is 
a reflection of the company. Illegal, lewd, or any behavior deemed inappropriate by the company will not be tolerated. 
Abusive or Inflammatory comments or behaviors that infringe on another person’s rights, gender race or personal 
beliefs / religion will not be tolerated. 
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SOCIAL MEDIA: FACEBOOK
• Like the Lightspeed GMI Facebook 

page!

• Visit the Lightspeed GMI Facebook 
page as we build employee 
awareness of internal events, 
corporate responsibility and social 
gatherings. 

Note: As an employee of Lightspeed GMI, your online behavior on personal,  private or public social media accounts is 
a reflection of the company. Illegal, lewd, or any behavior deemed inappropriate by the company will not be tolerated. 
Abusive or Inflammatory comments or behaviors that infringe on another person’s rights, gender race or personal 
beliefs / religion will not be tolerated. 
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SOCIAL MEDIA: LINKEDIN
• Join the Lightspeed GMI Group on 

LinkedIn

• Stay involved with our strategic 
vision as we publish our white 
papers, promote our thought 
leadership and product suite and 
also advertise our external blogs. 

Note: As an employee of Lightspeed GMI, your online behavior on personal,  private or public social media accounts is 
a reflection of the company. Illegal, lewd, or any behavior deemed inappropriate by the company will not be tolerated. 
Abusive or Inflammatory comments or behaviors that infringe on another person’s rights, gender race or personal 
beliefs / religion will not be tolerated. 
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THANK YOU.
FOR MORE INFORMATION ON THE VISUAL 
BRANDING GUIDELINES CONTACT:

ALISSA NEIBERT
Global Marketing Graphic Designer
+1.908.630.5043
aneibert@lightspeedresearch.com

FOR MORE INFORMATION ON THE 
COMMUNICATIONS GUIDELINES CONTACT:

LAURA JASINSKI
Global Communications Director
+1.908.605.4749
ljasinski@lightspeedresearch.com

mailto:aneibert@lightspeedresearch.com�
mailto:ljasinski@lightspeedresearch.com�
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